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Program Description
What is WinZip® Self-Extractor?
WinZip Self-Extractor is a utility program that creates native Windows self-extracting Zip files. These self-
extracting Zip files are ideal for Internet file distribution because they:    (1) can contain multiple 
compressed files, ensuring that important files do not become separated from the rest of the package; (2) 
allow the receiver to use a familiar Windows interface to decompress files, without owning or knowing 
how to use a separate unzip utility; and (3) optionally run a "setup" or "installation" program, which may 
be included by the developer when the files are decompressed. 
WinZip Self-Extractor is a more powerful version of WinZip Self-Extractor Personal Edition, which is 
included with WinZip®, an award winning utility to manipulate Zip files.    For more information on WinZip 
see the section titled About WinZip.
For information describing Zip files and self-extracting Zip files, the benefits of self-extracting Zip files, and
a brief overview of WinZip Self-Extractor operation, see the section titled About Self-Extracting Zip Files
Summary Of Key WinZip Self-Extractor Features

· Easy distribution of one or more compressed files.
· Low overhead (as little as 12k depending on options).
· Optional support for 32-bit (Windows 95 and Windows NT) self-extracting Zip files, including 

support for Microsoft® Authenticodeä technology.
· Optional support for Windows+MS-DOS self-extracting Zip files, so users without Windows can 

unzip your files.
· Use your own icon for self-extracting Zip files.
· An optional command is run when the unzip operation completes, making it easy to run a SETUP 

program included in a self-extracting Zip file.
· Any folder information in the Zip is automatically restored.
· 100% compatible with the Zip 2.0 standard.

Awards and Magazine Quotes
"WinZip Self-Extractor: Another five-star gem" ZDNet AnchorDesk, 1/13/97
“All Star Award”, MultiMedia World, 6/96
"Finalist", 1995 Ziff-Davis Shareware Awards
"Recommended Download", Windows Magazine 6/95
"Unzipping self-extracting files is as easy as double clicking on an icon", PC Magazine, 5/16/95



About Self-Extracting Zip Files
This topic describes Zip files and self-extracting Zip files, discusses the benefits of self-extracting Zip files,
and briefly describes how self-extracting Zip files work.
What is a Zip file? 
The Zip file format is an industry standard for compressing and grouping files.    One Zip file can contain 
multiple files.    Files contained in a Zip are usually compressed.    
Typical uses for Zip files include:

· Most files available in "file areas" on bulletin boards and electronic services like CompuServe and
the Internet are distributed as Zip files.    Two benefits of using Zip files for electronic file 
distribution are that only one file transfer operation ("download") is required to obtain all related 
files, and file transfer time is minimized because the files in a Zip are compressed.

· It is often useful to send a group of related files to an associate.    Rather than distributing 
individual files it is often easier to distribute the files as a Zip file to benefit from the file grouping 
and compression.

Zip files are created using a Zip utility like WinZip® or the PKZIP® utility from PKWARE®.
What is a Self-Extracting Zip File?
A self-extracting Zip file is an executable program file (.EXE file) that includes a Zip file and software to 
extract or "unzip" the contents of the Zip file.    Users can run (execute) a self-extracting Zip file just as 
they run any other program.
When a self-extracting Zip file created by WinZip Self-Extractor is run, a dialog box is displayed.    This 
dialog box makes it easy for the user to change the "unzip to" folder and change other options before 
extracting or "unzipping" the files in the self-extracting Zip file.
Self-extracting Zip files created by WinZip Self-Extractor    are

· 100% compatible with the Zip 2.0 file format, so they can be unzipped by standard unzip utilities 
like WinZip and PKUNZIP.

· Only about 12k larger than a regular (not self-extracting) Zip file when using default options.
What are the advantages to Self-Extracting Zip Files?
Users can extract or "unzip" files from a self-extracting Zip file without running a separate unzip utility or 
knowing how to use an unzip utility.    Thus self-extracting Zip files are particularly suited for distribution of 
software to beginning users who are not familiar with the concept of Zip files.
Self-extracting Zip files created by WinZip Self-Extractor are native Windows programs so they are easy 
to use even for users with no MS-DOS experience.
How Does it Work?
There are two parts to WinZip Self-Extractor:

1) The WinZip Self-Extractor program creates self-extracting Zip files.
2) When WinZip Self-Extractor creates a self-extracting Zip file it includes part of itself in the self-

extracting Zip file.    The part of WinZip Self-Extractor included in the self-extracting Zip file is what
makes it possible to unzip the files by simply running the self-extracting Zip file.

The person who creates the self-extracting Zip file runs WinZip Self-Extractor once, specifying the name 
of the Zip file and options, including the default "unzip to" folder and a program to be run automatically 
when the unzip operation completes.    WinZip Self-Extractor stores this information in the self-extracting 
Zip file so it is available when the self-extracting Zip file is run.    See the section titled Creating Self-
Extracting Zip Files for details on the procedure, and the section titled Copyright/License/Warranty for 
information on licensing.



Copyright/License/Warranty

Copyright
WinZip® Self-Extractor Copyright © 1995-1997 by Nico Mak Computing, Inc.
All rights reserved.

License Agreement
You should carefully read the following terms and conditions before using this software.    Unless you have
a different license agreement signed by Nico Mak Computing, Inc., your use of this software indicates 
your acceptance of this license agreement and warranty.
For information on distributing the evaluation version of WinZip Self-Extractor see the section titled 
Evaluation License.
Registered Version
Each registered copy of WinZip Self-Extractor may be used at a single workstation to create an unlimited 
number of freely distributable royalty-free self-extracting Zip files, subject to the following conditions:

· A separate registered copy of WinZip Self-Extractor must be obtained for each workstation on 
which WinZip Self-Extractor will be used to create self-extracting Zip files, even if such use is only
temporary.    This is not a "concurrent use" license.

· Self-extracting Zip files created by WinZip Self-Extractor contain, among other things, a portion of 
WinZip Self-Extractor, including copyrighted software, proprietary notices, and identifying 
information (the "Extraction Software").    No registered user, nor anyone else, may alter or modify
the Extraction Software.    You cannot give anyone else permission to modify the Extraction 
Software.

All rights not expressly granted in this license agreement are reserved entirely to Nico Mak Computing, 
Inc.
Governing Law
This agreement shall be governed by the laws of the State of Connecticut.

Disclaimer of Warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT 
WARRANTIES AS TO PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES 
WHETHER EXPRESSED OR IMPLIED.    Because of the various hardware and software environments 
into which WinZip Self-Extractor may be put, NO WARRANTY OF FITNESS FOR A PARTICULAR 
PURPOSE IS OFFERED.
Good data processing procedure dictates that any program be thoroughly tested with non-critical data 
before relying on it.    The user must assume the entire risk of using the program.    ANY LIABILITY OF 
THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT REPLACEMENT OR REFUND OF 
PURCHASE PRICE.



Evaluation License
Evaluation and Registration
This is not free software.    You are hereby licensed to use the evaluation version of WinZip Self-Extractor 
for evaluation purposes without charge for a period of 21 days.    If you use this software after the 21 day 
evaluation period a registration fee is required, as described in the WinZip Self-Extractor order form.
Under no circumstances are you licensed to distribute self-extracting Zip files created by the evaluation 
version of WinZip Self-Extractor.
Unregistered use of WinZip Self-Extractor after the 21-day evaluation period is in violation of U.S. and 
international copyright laws.
Distribution of WinZip Self-Extractor
You are hereby licensed to make as many copies of the evaluation version of this software and 
documentation as you wish; give exact copies of the original evaluation version to anyone; and distribute 
the evaluation version of the software and documentation in its unmodified form via electronic means.    
There is no charge for any of the above.    
You are specifically prohibited from charging, or requesting donations, for any such copies, however 
made; and from distributing the software and/or documentation with other products (commercial or 
otherwise) without prior written permission.



Order Form
WinZip® Self-Extractor 2.1 Registration Form/Invoice
To print this order form, click on Print Topic in the File pull-down menu.
New:    You can place secure credit card orders via the World Wide Web using the Order link on the 
WinZip home page: http://www.winzip.com.
Customer information is considered confidential and will not be shared or distributed to any third party.
Ordering by check:    To order by check send this order form and a check to "WinZip Self-Extractor", 
Nico Mak Computing, Inc., P.O. Box 540, Mansfield, CT 06268, USA.    Payments must be in US dollars 
drawn on a US bank, or you can send international postal money orders in US dollars.
Credit card ordering:    For information on ordering by MasterCard, Visa, American Express, or Discover 
by phone, FAX, or CompuServe email, or postal mail, click here: Credit Card Ordering.
CompuServe Registration:    To have the registration fee added to your CompuServe bill type GO 
SWREG at the ! prompt and register product ID 4866.
Purchase Orders:    For information on using purchase orders click here: Purchase Orders.
Prices guaranteed through June, 1998.
WinZip Self-Extractor is shipped on 3.5" disks only.
Single Copy  ____  copies at   $49 each     = ______
Five-Pack    ____  5-packs at $199 each     = ______
  A Five-Pack includes ONE copy of the
  software and a license to duplicate the
  software as needed to create self-
  extracting Zip files on up to five
  workstations at one organization.
Connecticut residents add 6% sales tax      + ______
                         Total payment        ______
Please be sure to print clearly!  Your organization name is required and will 
be imbedded in all self-extracting Zip files created by your registered copy 
of WinZip Self-Extractor.
            Name: ______________________ Date:___________
    Organization: _______________________________________
         Address: _______________________________________
City, State, Zip: _______________________________________
         Country: _______________________________________
       Day Phone: ______________  Eve:  _________________
Electronic Mail address:  _______________________________
How did you hear about this product? ____________________
Comments:



Credit Card Ordering Information
To print this order form, click on Print Topic in the File pull-down menu.    
You can place secure credit card orders via the World Wide Web using the Order link on the WinZip home
page: http://www.winzip.com.    You can also place MasterCard, Visa, American Express, and Discover 
orders for WinZip Self-Extractor through PsL.    The best way to reach PsL is by fax to 1-713-524-6398 
or by CompuServe mail to 71355,470 or Internet mail to 71355.470@compuserve.com.    You can also 
call PsL at 1-800-242-4PsL(4775) or 1-713-524-6394 between the hours of 8:30 am and 5:00 pm CST 
Monday-Friday, except holidays.
Credit card orders can be mailed to PsL at P.O. Box 35705, Houston, TX 77235 USA.
PsL requires the following information:
Credit Card [ ] MasterCard [ ] VISA [ ] AMEX [ ] Discover
Credit Card Number: _____________________________________
Expiration Date:    _____________________________________
Name On Card:       _____________________________________
Billing Address:    _____________________________________
                    _____________________________________
                    _____________________________________
PLEASE INCLUDE THE STANDARD WINZIP SELF-EXTRACTOR ORDER FROM THE PREVIOUS 
PAGE WITH YOUR ORGANIZATION NAME ETC
Nico Mak Computing, Inc. cannot be reached at the numbers above.
These numbers are for PsL, a credit card order taking service only.
Any questions about the status of the shipment of an order, refunds, registration options, product details, 
technical support, volume discounts, dealer pricing, site licenses, etc., must be directed to Nico Mak 
Computing, Inc., P.O. Box 540, Mansfield, CT 06268, USA or by CompuServe mail to 70056,241 or by 
Internet mail to 70056.241@compuserve.com.



Purchase Orders
Purchase orders (net 30 days) are accepted only from government and accredited educational institutions
and major corporations, provided that they are submitted on purchase order forms with a purchase order 
number.    Purchase orders should be sent to Nico Mak Computing, Inc., P.O.    Box 540, Mansfield, CT 
06268.    Please be sure to include the standard WinZip Self-Extractor order form with a purchase order.    
The Federal Tax Id for Nico Mak Computing, Inc. is 06-1378727. Due to the extra work involved in 
processing purchase orders you are encouraged to use a credit card, CompuServe's SWREG registration
service, petty cash, or an expense account when possible for small orders.



About WinZip®
WinZip is an award-winning utility that brings the convenience of Windows to the use of Zip files.    WinZip 
includes built-in PKZIP compatible ZIP and UNZIP, so PKZIP and PKUNZIP are not needed for basic 
archive operations, and features an intuitive point and click interface for viewing, running, extracting, 
adding, deleting, and testing files in archives.    Optional virus scanning support is included.
The WinZip product includes WinZip Self-Extractor Personal Edition.    For more information, see the 
section titled Differences between WinZip Self-Extractor and the Personal Edition.
WinZip won the 1997 Home Office Computing "Editor's Pick" Award, 1996 PC Week Labs "Analyst 
Choice" Award (December 9), PC Magazine 1996 Best Utility Shareware Award, the Windows Magazine 
1996 WIN100 Award, was a finalist for the PC Computing 1995 MVP Awards at Comdex, and was voted 
"Best Utility" at the 1994 Shareware Industry Awards. WinZip Self-Extractor was a finalist for the 1995 Ziff-
Davis Shareware Awards.    
Magazine quotes include:

· "Easy to learn yet robust enough to satisfy power users", PC Magazine, 4/8/97
· "For working with .ZIP archives, there's no better tool than WinZip", Windows Sources, 3/97
· "It's rare to find one product in a hard-fought market category that bests its competition in nearly 

every respect.    WinZip 6.2 is one of these products.    It towers over the rest of the market."    PC 
Week 12/9/96

· "Of the many file-compression and extraction utilities out there, this one is the best - and the 
easiest to use" Windows Magazine, 11/96

· "The best data-compression and archiving utility around" PC Computing 7/96
You can download an evaluation copy of WinZip from the WinZip home page (http://www.winzip.com) or 
the GO WINZIP area on CompuServe.



Differences between WinZip Self-Extractor and the Personal Edition
WinZip Self-Extractor Personal Edition is included with WinZip  â  .    WinZip Self-Extractor 2.1, a $49 
add-on to WinZip, includes the following features not available in the Personal Edition:

· Features to automate and customize software installation, such as the ability to specify an icon 
and text for the main self-extractor dialog box, and to delete temporary files after running a setup 
program.    It includes support for the InstallShield 3.0 SETUP program.

· Ability to run a command when the unzip operation completes.
· Self-Extracting files can be created from the command line.
· An option to create a single self-extracting Zip file that runs under either MS-DOS or Windows.
· All versions can be created with English or German messages.
· Ability to automatically extract files when the EXE file is run.
· A Wizard to simplify the process of building self-extracting files.
· Support for password protected Zip files.
· All 32-bit self-extracting Zip files support Microsoft® Authenticodeä technology.
· User-specified icons.
· An option to create self-extracting Zip files that unzip automatically.

Note: some of these features may be included in future versions of WinZip Self-Extractor Personal 
Edition.



Version History
WinZip® Self-Extractor 2.1 is a superset of versions 2.0 and 1.0.    Everything that worked with earlier 
versions works the same way with 2.1, but new features are available, including:

· Password support:    all types of self-extractors except "Compact" and "MS-DOS + Windows" 
support industry standard Zip encryption.

· All 32-bit self-extracting Zip files support Microsoft® Authenticodeä technology.    In earlier 
versions, the self-extracting Zip file's integrity check conflicted with Authenticode.    (For 
information on Authenticode, visit the Microsoft home page, click the "Search" button and search 
for "authenticode code signing".)

· User-specified icons:    you can use an icon of your choice for all types of self-extractors except 
"Compact" and "MS-DOS + Windows".    These icons are displayed in the Explorer (in version 2.0,
user-specified icons were only used in the dialog box of self-extractors for software installation).

· While version 2.0 made it possible to build 32-bit self-extracting Zip files, the program that created
these 32-bit files was actually a 16-bit program.    A 32-bit version (wzipse32.exe) is now included.

· You can now create self-extracting Zip files that unzip automatically.    (In version 2.0 the end-user
had to specify /auto on the command line while running the self-extracting file to unzip 
automatically.)    Use this new feature with caution:    if you are planning to post this file on the 
Internet or an online service like CompuServe or AOL, you should be aware that some sysops 
refuse to accept files that unzip without a prompt.

· The “Mail Self-Extracting Zip File” button in the final wizard panel makes it easy to send a self-
extractor to another user by e-mail (this feature is available only if your system supports MAPI, 
the standard Mail Application Program Interface).

Version 2.0 added these features:
· Options to create self-extracting ZIP files with new headers:

· 32-bit Win32 headers
· 16-bit Windows headers with Windows 95 long filename support
· MS-DOS support (one EXE works on either MS-DOS or Windows) 

· Improved automation and customization for software installation, such as the ability to specify an 
icon and text for the main dialog box, and to delete temporary files after running a setup program. 
Includes support for InstallShield Corporation’s SETUP program.

· All versions can be created with English or German messages.
· Ability to automatically extract files when EXE file is run.
· An optional progress meter while unzipping.
· An uninstall facility for the WinZip Self-Extractor package.
· Command lines options can be included in a file using the @filename syntax, for example

“winzipse <some options> @”continued_options.inp”.
· A Wizard to simplify the process of building self-extracting files.
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Technical Support
Technical support is available at no charge.    Support options are:

CompuServe
:

enter GO WINZIP and leave a message in the WinZip 
section, or send email to 70056,241

Internet: send email to support@winzip.com
Postal Mail: write to "Technical Support", Nico Mak Computing, Inc., P.O. 

Box 540, Mansfield, CT 06268 USA

Related Topics:

Solutions to Common Problems
Hints and Tips
Tips for Creating Self-Extractors for Software Installation



Solutions To Common Problems
1) If someone downloads a self-extracting Zip file and reports that they get the system message "out

of memory" when trying to run it, the reason is usually that the file was corrupted during the file 
transfer.    Both DOS and Windows often issue "out of memory" errors when you attempt to 
execute invalid executable files.    Usually the best solution to this problem is for the user to obtain
another copy of the self-extracting Zip file. 

2) If the WinZip Self-Extractor dialog box is not displayed when a user runs a self-extracting Zip file, 
the reason is usually that an EXE, FON, DLL, or DRV file with the same name is already running 
on the user's system.    For example, if you create an EXE file called USER.EXE, you will not be 
able to run it because Windows automatically loads a file called USER.EXE, and Windows does 
not allow you to run two different files with the same name.    WinZip Self-Extractor checks for 
conflicts on your machine when you create a self-extracting Zip file, but it is of course impossible 
to check for conflicts on your users machine.    A simple solution to this problem is to rename the 
self-extracting Zip file.

3) If you have trouble getting a Self-Extracting Zip file for Software Installation to work, see the 
section Tips for Creating Self-Extractors for Software Installation.

Related Topics:

Technical Support
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Tips for Creating Self-Extractors for Software Installation



Hints and Tips
1. When running WinZip Self-Extractor from a BAT file or "make" file under Windows 95 you can 

wait for WinZip Self-Extractor with the command
START /WAIT WINZIPSE.EXE -y [other options] filename.zip
To avoid the 127 character command line length limit, you can use the “@-response file syntax” 
described in the section titled Command Line Options.

2. If you are running a self-extracting Zip file from another program, you can specify the /auto 
parameter to unzip the files without user interaction.    This option has the same effect as clicking 
the Unzip button when the main dialog box is displayed, and, if the unzip operation is successful, 
clicking the Close button.    You can specify a folder name to unzip files into that folder, for 
example, if modem.exe is a self-extracting file, the command

modem.exe /auto c:\modem

will automatically extract files into the c:\modem folder.
3. To make the default Unzip To the folder containing the self-extracting zip file, specify “.” (a single 

period, with no quotes) as the folder name when creating the self-extracting zip file.
4. If you create a 32-bit self-extractor and specify a file inside your Zip file as the "command to issue

when the unzip operation completes", insert the characters ".\" in front of the command.    This will
ensure that the command in the Zip file is run, even if a file with the same name exists in the 
directory containing the self-extractor.    For example
.\setup.exe

5. You can use the -ST command line switch to specify text for the title bar of your self-extracting Zip
file.    For example, the command
winzipse -st”Installation Program” filename.zip
will put the text Installation Program in the initial dialog displayed when your self-extractor is 
executed.

6. If you have trouble getting a Self-Extracting Zip file for Software Installation to work, see the 
section Tips for Creating Self-Extractors for Software Installation.

Related Topics:
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Tips for Creating Self-Extractors for Software Installation
Self-Extracting Zip file for Software Installation take a bit more work to set up than Standard Self-
Extracting Zip File, but provide a more professional looking installation.    If you are having trouble 
getting a Self-Extracting Zip file for Software Installation to work, try these tips:

1) Try building a Standard Self-Extracting Zip File.    If a Standard Self-Extracting Zip files works, 
check the Wait for field in the Wizard, or the -wait parameter if you are using command line 
options.    If you are using InstallShield, be sure you have version 3.0 and have included the file 
_isdel.exe in your Zip file.

2) Keep in mind that a Self-Extractor for Software Installation is designed to work with installation 
programs that would normally copy all files from a floppy disk or CD-ROM.    A Self-Extractor for 
Software Installation unzips files to a temporary directory, runs the command you specify, and 
when that command completes, it DELETES ALL THE TEMPORARY FILES, without regard to 
any further processing you have planned for the extracted files.    Therefore, it is necessary for the
setup command to make permanent copies of files extracted from the self-extracting archive 
before they terminate, if permanent copies are needed, just as the setup command would need to
copy files from a floppy disk or CD-ROM.    Self-Extractors for Software Installation ALWAYS unzip
to a temporary directory; if you need to unzip to a specified directory, you must use a Standard 
Self-Extracting Zip File.

3) The following applies only if you are using Visual Basic's Application Setup Wizard.    This Setup 
Wizard creates a two-step installation process, similar in some ways to InstallShield's setup/_isdel
pair of application setup programs.    Such a Visual Basic application installation begins when the 
program named "setup" runs.    The setup program launches, in turn, a program named setup1 
(or, if you are using a 32-bit edition of Visual Basic, a program named setup132).    The setup1[32]
program completes the application installation procedure.    If you wish to package such a Visual 
Basic application installation procedure in a software installation self-extractor, you will need to 
specify
setup
as the default command to execute after the unzip operation completes, and
setup1 (or setup132)
as the "Wait For" command, either in the appropriate WinZip Self-Extractor Wizard panel, or via 
the WinZip Self-Extractor command line options.    Failure to specify setup1 (or setup132) as the 
"Wait For" command could result in WinZip Self-Extractor prematurely deleting your application 
setup files, resulting in an incomplete installation or in some other error.

While it is possible that WinZip Self-Extractor will not be able to wait for your install program, please 
check the “WinZip Self-Extractor” page on the WinZip site for the latest information.    If you have 
questions, let us know.

Related Topics:
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System Requirements
Documentation:
The documentation assumes you know how to use Windows, and know how to create Zip files.
Creating Self-Extracting Zip files:
WinZip® Self-Extractor does not create Zip files, so you need a utility like WinZip that creates Zip files.
Standard English language self-extracting Zip files without long filename support and MS-DOS support 
can be created under MS-DOS or Windows, as with WinZip Self-Extractor 1.0.    All other self-extracting 
files can only be created under Windows (3.1, 95, or NT).
Running Self-Extracting Zip files:
32-bit Win32 self-extracting files can only be run under Windows 95 and Windows NT.
Except the "compact" header, all 16-bit headers self-extracting Zip files support long filename under 
Windows 95.    The current versions of Windows NT do not let 16-bit applications access long filenames, 
so 32-bit self-extracting files are recommended if you use long filenames targeted for Windows NT.



WinZip Self-Extractor Distribution Files
Filename Description
README.TXT introductory information
LICENSE.TXT license agreement/warranty
WINZIPSE.TXT extracts from online documentation
WINZIPSE.HLP documentation in online hypertext help format
WINZIPSE.EXE required executable (for Windows 3.1, 95, and NT)
WZIPSE32.EXE required executable for Windows 95 and NT
ORDER.TXT order form
WHATSNEW.TXT list of recent changes
FILE_ID.DIZ brief description for bulletin boards
VENDOR.TXT information on distribution of the evaluation version
SETUP.EXE * 32-bit installation program helper
SETUP32.EXE * installation program

Note: files marked with an asterisk are not copied to your hard disk.



Installation
To install WinZip® Self-Extractor simply run the SETUP program on the distribution disk and follow the 
prompts.    This will install the files and create a program group called WinZip Self-Extractor.



Uninstallation
WinZip Self-Extractor includes an “uninstall” facility.    You can run it as follows:

· Under Windows 3.1 and Windows NT 3.5 and 3.51: activate the Program Manager, select WinZip 
Self-Extractor from the Window menu, and double click on the “Uninstall WinZip Self-Extractor” 
icon.

· Under Windows 95 or Windows NT 4.0: from the Start menu select Programs->WinZip Self-
Extractor->Uninstall WinZip Self-Extractor.

You can also uninstall WinZip Self-Extractor manually by following these instructions:
1. Using the Windows File Manager, Explorer, or some other utility, delete the WinZip Self-Extractor 

folder and all of the files it contains.
2. Delete WinZip Self-Extractor's icons and program group.    Under Windows 3.1 or NT 3.51, 

activate the WinZip Self-Extractor group and then press the Delete key repeatedly until all of the 
icons have been deleted. After the group is empty, you can press the Delete key one more time to
delete the group itself.    Under Windows 95 or NT 4.0, select Settings->Task Bar from the Start 
menu, click the Start Menu Programs tab, click Remove, select WinZip Self-Extractor, then push 
the Remove button.

3. If you have specified WinZip Self-Extractor as the “Make EXE” program in WinZip, activate 
WinZip, select Program Locations from WinZip’s Options menu, then blank out the Make Exe 
field.



Creating Self-Extracting Zip Files
To create a self-extracting Zip file first run WinZip® Self-Extractor.    You can do this in one of three ways:

1. Start WinZip Self-Extractor like any other Windows program:
Under Windows 95: select Start->Program Files->WinZip Self-Extractor->WinZip Self-Extractor
Under Windows 3.1: double click on the WinZip Self-Extractor icon in the WinZip Self-Extractor 
program group

2. Run WinZip Self-Extractor directly from WinZip 6.0 or later.    Just select Make EXE File from the 
WinZip Options menu and use the WinZip Self-Extractor Wizard.    Before doing this you must first
specify the full filename (including folder information) of WinZip Self-Extractor in the Make EXE 
field in the WinZip Options/Program Locations dialog box.    When WinZip Self-Extractor is run for 
the first time on your system it will offer to do this for you if it detects WinZip installed on your 
system.

3. Run WinZip Self-Extractor from the DOS prompt:    Command line options are required for this 
choice.    For a list of options see the section titled Command Line Options.

Notes:
· When the self-extracting Zip file is run, any folder information stored in the Zip file will 

automatically be used.
· WinZip Self-Extractor does not handle password protected Zip files or Zip files that span disks.



Password Security
You can create all types of self-extractors except "Compact" and "MS-DOS + Windows" from Zip files 
encrypted with industry standard Zip password protection.    To create password protected Zip files you 
need WinZip or a compatible Zip utility.    Then you can use WinZip Self-Extractor to create an encrypted 
self-extracting Zip file from the encrypted Zip file, just as you would create a non-encrypted self-extracting
Zip file from a non-encrypted Zip file.    A user is prompted for the password when the self-extracting Zip 
file is run.    Unless the correct password is supplied, the files will not be extracted.
WinZip uses the industry standard Zip 2.0 encryption format.    Password protecting files in a Zip provides 
a measure of protection against casual users who don't have the password and are trying to determine 
the contents of your files.    The Zip 2.0 encryption format, however, is not as secure as DES and the RSA 
public key formats used by programs such as PGP, and does not provide absolute protection against 
determined individuals with advanced cryptographic tools.    Note:    there are two reasons WinZip does 
not implement a more secure encryption format:    (1) a different format would not be compatible with the 
Zip 2.0 standard, so other Zip utilities would not be able to decrypt the files, and (2) there are currently 
severe U.S. government restrictions on the export of encryption technology.    If you require strong 
encryption, we recommend you use a specialized encryption software instead of the Zip 2.0 encryption 
format.



The Main WinZip Self-Extractor Window
*** OBSOLETE *** REPLACED BY WIZARD ***
When you start WinZip® Self-Extractor a dialog box with the following fields is displayed:

· The name of the Zip file to turn into a self-extracting Zip file.    You can either type the name, or 
press the Browse button and use the standard Open dialog box to select a Zip file.    Alternately, 
you can use the standard File Manager drag and drop interface to drop a Zip file onto WinZip 
Self-Extractor, or, if you have installed WinZip Self-Extractor in WinZip, simply select Make .EXE 
File from a WinZip window.

· The default target folder for the unzip operation.    If left blank the folder specified by the user's 
TEMP= environment variable is used.    This is generally the best choice if your Zip file contains a 
SETUP program that will copy the unzipped contents of the Zip file to another folder.    If you do 
not have a SETUP program you will probably want to choose a name related to the contents of 
the Zip.    For example, you might use "c:\modem" for a Zip containing a help file called 
"modem.hlp".    This field is the equivalent of the -d command line option.

· The optional command to execute when the unzip operation completes.    This command will be 
issued from the user's Unzip To Folder, so folder information is generally not needed in this 
command.    The command can be a program already installed on the user’s machine, such as 
NOTEPAD or WINHELP, or it can be a program you have included in the Zip file, such as your 
own SETUP.EXE.    (Technical note for interested software developers: the optional command is 
run via the WinExec API function, not the ShellExecute API function.)    You must specify a 
command name, not just a filename.    Typical commands are:
· SETUP - to run the SETUP program in the Zip file
· WINHELP myfile.HLP - to start the Windows HELP engine on a file in the Zip
· NOTEPAD myfile.TXT - to start NOTEPAD on a file in the Zip
This field is the equivalent of the -c command line option.

· Four types of self-extracting Zip files can be created:
1. Compact 16-bit Windows:    This option creates self-extracting Zip files without long filename 

support or a progress meter.    If long filenames are not used, these files work under Windows
3.1, Windows 95, and Windows NT.    (Historical note: these files are almost identical to those 
created by WinZip Self-Extractor 1.0).

2. Standard 16-bit Windows: This option creates self-extracting Zip files with long filename 
support and a progress meter.    However, if long filenames are used and the self-extracting 
Zip is run on a system that does not support the 16-bit long filename APIs (e.g. the current 
version of Windows NT), a message box is displayed warning the user of potential problems, 
and any long filenames will be truncated.    This message box is displayed after the optional 
comment message box.

3. MS-DOS and 16-bit Windows:    This option creates self-extracting Zip files that can be run 
either from Windows or from the MS-DOS prompt.    Long filenames are not supported, since 
MS-DOS does not support them.

4. 32-bit Windows 95 and NT:    This option creates self-extracting Zip files that include long 
filename support under Windows 95 and Windows NT.    Because these self-extracting files 
are full 32-bit programs they will not run under Windows 3.1.

These options correspond to the -compact, -standard, -dos, and -win32 command line options.
· Whether English language or German language self-extracting Zip files should be built.
· Whether the CTL3D.DLL should be used to generate 3D effects for the self-extracting Zip file.    

CTL3D.DLL is used by many applications to generate 3D effects so there is a good chance it will 
exist on a lot of target systems.    If this option is specified WinZip will try to load CTL3DV2.DLL, 
and if not found, will try to load CTL3D.DLL.    Note that there is no way for WinZip Self-Extractor 



to guarantee that the CTL3D*.DLL on the target system will function properly.    This field is the 
equivalent of the -3 command line option.

Press the Make EXE button to create the self-extracting Zip file.    Be sure to test the Zip file before 
distributing it.



Command Line Options
Command line options can be used to automate the processing of self-extracting Zip files via bat files and
“make” files.    When command line options are specified the main WinZip Self-Extractor Window is 
normally not displayed.
The command line format is:

winzipse[.exe] filename[.zip] [options]
Due to system limits, the total length of the command line is limited to 127 characters.    To specify a long 
command line, you can put command line options into a file, and specify the filename using the “@-sign 
response file syntax”.    For example, if the ASCII text file “standard.inp” contains the lines

-compact -d c:\modem
-m c:\folder\greeting.txt
-nooverwrite

You can use the command
winzipse filename.zip @standard.inp

To build a self-extracting Zip file with the options in the file standard.inp.
For detailed command line syntax, see the sections titled Command Line Options for Standard Self-
Extracting Zip Files and Command Line Options for Self-Extracting Zip Files for Software Installation.

Note: If you run a self-extracting Zip file from another program, you can pass the /auto parameter to unzip
the files without user interaction.    This option has the same effect as clicking the Unzip or Setup button 
when the main dialog box is displayed, and, if the unzip operation is successful, clicking the Close button. 
You can specify a folder name to unzip files into that folder when using standard self-extracting Zip files.    
For example, if modem.exe is a self-extracting file, the command

modem.exe /auto c:\modem

will automatically extract files into the c:\modem folder.



Command Line Options for Standard Self-Extracting Zip 
Files
Valid options when building Standard Self-Extracting Zip Files are:

-y Required for operation from the command line. Automatically 
respond "yes" to the "overwrite file" prompt, and do not display
password warning message.

-3 Use CTL3D.DLL for 3D effects if available on the target 
system.

-d <folder> Default "unzip to" folder.
-i <fileid> File containing icon for the self-extractor (standard .ico file 

format).
-m<fileid> Message (comment) file displayed when self-extracting Zip is 

run.    The default is WINZIPSE.DIZ if it exists in the folder 
containing the Zip file.

-compact Create compact 16-bit Windows file.    This option creates self-
extracting Zip files without long filename support or a progress
meter.    If long filenames are not used, these files work under 
Windows 3.1, Windows 95, and Windows NT.    (Historical 
note: these files are almost identical to those created by 
WinZip Self-Extractor 1.0).

-standard Create standard 16-bit Windows file. This option creates self-
extracting Zip files with long filename support and a progress 
meter.    However, if long filenames are used and the self-
extracting Zip is run on a system that does not support the 16-
bit long filename APIs (e.g. the current version of Windows 
NT), a message box is displayed warning the user of potential 
problems, and any long filenames will be truncated.    This 
message box is displayed after the optional comment 
message box.

-dos Create MS-DOS and 16-bit Windows file.    This option creates
self-extracting Zip files that can be run either from Windows or 
from the MS-DOS prompt. Some limitations apply to these 
files; see the section titled Limitations on “MS-DOS and 16-bit 
Windows” Self-Extractors for details.

-win32 Create 32-bit Windows 95 and NT file.    This option creates 
self-extracting Zip files that include long filename support 
under Windows 95 and Windows NT.    Because these self-
extracting files are full 32-bit programs they will not run under 
Windows 3.1.

-le Language English
-lg Language German
-overwrite Overwrite checkbox in self-extracting file is initially checked
-nooverwrite Overwrite checkbox in self-extracting file is initially not 

checked
-auto The “Unzip” button is automatically pressed when the self-

extracting Zip file is run. Use this new feature with caution:    if 
you are planning to post this file on the Internet or an online 
service like CompuServe or AOL, you should be aware that 



some sysops refuse to accept files that unzip without a 
prompt.

-st”<title>“ Specify the text for the title bar of the self-extracting Zip file.    
This option is ignored for Compact and MS-DOS+Windows 
self-extracting Zip files.

-c <command> Default command to execute after unzip operation completes.  
If specified, this option must be last. This command will be 
issued from the user's Unzip To Folder, so folder information 
is generally not needed in this command.    The Windows 
WinExec API is used to run this command.    You must 
specify a command name, not just a filename.

Example of usage:
C> winzipse filename -d c:\modem -c winhelp modem.hlp
This command turns filename.zip into a self-extracting Zip file called filename.exe.    The default "unzip to"
folder is "c:\modem" and the command that is automatically executed after the unzip operation completes 
is "winhelp modem.hlp".
Note:
You can place command line options into a response file as described in the topic Command Line 
Options.



Command Line Options for Self-Extracting Zip Files for 
Software Installation
Valid options when building Self-Extracting Zip file for Software Installation are:

-setup Create a Self-Extracting Zip file for Software Installation.
-t <fileid> File containing text for the main self-extractor dialog box
-i <fileid> File containing icon for the self-extractor (standard .ico file 

format).    This icon will be used for the EXE file and in the 
dialog box.

-a <fileid> File containing extra text for the self-extractor “About” dialog 
box

-3 Use CTL3D.DLL for 3D effects if available on the target 
system.

-wait<name> Wait for name instead of the command to complete.    Name 
must be a filename when building 32-bit self-extracting Zip 
files, or a module name when building 16-bit self-extracting Zip
files. See the section titled Command To Issue When Unzip 
Operation Completes for information on this option.

-ishield3 Special option required for InstallShield 3.0 and InstallShield 
3.0 SDK Edition users. See the section titled Command To 
Issue When Unzip Operation Completes for information on this
option.

-win32 Create 32-bit Windows 95 and NT file.    This option creates 
self-extracting Zip files that include long filename support 
under Windows 95 and Windows NT.    Because these self-
extracting files are full 32-bit programs they will not run under 
Windows 3.1

-le Language English
-lg Language German
-auto The “Unzip” button is automatically pressed when the self-

extracting Zip file is run. Use this new feature with caution:    if 
you are planning to post this file on the Internet or an online 
service like CompuServe or AOL, you should be aware that 
some sysops refuse to accept files that unzip without a 
prompt.

-st”<title>“ Specify the text for the title bar of the self-extracting Zip file.
-c <command> Default command to execute after unzip operation completes. 

This option must be specified last. This command will be 
issued from the user's Unzip To Folder, so folder information 
is generally not needed in this command.    The Windows 
WinExec API is used to run this command.    You must 
specify a command name, not just a filename.

Notes:
· You can place command line options into a response file as described in the topic Command Line 

Options.
· To create a self-extractor for software installation via the command line without using the wizard 

interface, you must specify at least either



both the -setup and -c options

or

the -ishield3 option

other command line switctes are optional.



Running A Self-Extracting Zip File
To extract or "unzip" files in a self-extracting Zip file simply run the EXE file.    You can do this as follows:

· Under Windows 95 or Windows NT 4.0: select Run from the Start menu, type the full filename of 
the self-extracting Zip file, and press the Enter key.    Or type the full filename of the self-extracting
Zip file at the system command prompt, then press the Enter key.

· Under Windows 3.1 and Windows NT 3.5 and 3.51: activate the Program Manager, select Run 
from the File pull-down menu, type the full filename of the self-extracting Zip file, and press the 
Enter key.    Or, activate the File Manager and double click on the self-extracting Zip file.

Details on running Standard Self-Extracting Zip files:
When a Standard Self-Extracting Zip File is run, a dialog box is displayed with options to control

· The folder to which files are unzipped.
· Whether files are overwritten automatically or whether prompts are issued before each file is 

overwritten.
· Whether to run the optional command which was specified when the Zip was created.    This 

check box is hidden if no optional command was specified.
The Unzip button unzips all files to the specified folder.
The Run WinZip button opens the self-extracting Zip file with WinZip (assuming WinZip is installed on 
your system).    This gives you the ability to extract and view individual members, create a program group,
move the archive, etc.
The Close, About, and Help buttons close the Self-Extracting Zip, display copyright information, and 
display basic usage information, respectively.
Details on running Self-Extracting Zip files For Software Installation:
When a Self-Extracting Zip File for Software Installation is run, the resulting dialog box contains three 
push-buttons: Setup, Cancel, and Help.    These buttons will run the specified command in the Zip file, 
close the self-extracting Zip file, and display copyright and usage information, respectively.

Note: If you run a self-extracting Zip file from another program, you can pass the /auto parameter to unzip
the files without user interaction.    This option has the same effect as clicking the Unzip or Setup button 
when the main dialog box is displayed, and, if the unzip operation is successful, clicking the Close button. 
You can specify a folder name to unzip files into that folder when using standard self-extracting Zip files.    
For example, if modem.exe is a self-extracting file, the command

modem.exe /auto c:\modem

will automatically extract files into the c:\modem folder.



Using the WinZip Self-Extractor Wizard
The WinZip Self-Extractor Wizard provides an easy-to-use system for building self-extracting Zip files. 
Just click the Next button to step through a series of panels that step you through the process of creating 
a self-extracting Zip file.    You can click Back at any time to change settings in a previous panel.    Click 
the Help button in any panel for details on the options controlled by that panel.



Two Kinds of Self-Extracting Files
Standard Self-Extractors
Standard Self-Extractors are easy to build and are ideal for sending documents, graphics, and other files 
to co-workers and associates.    They are also suitable for simple software installation.    Standard Self-
Extractors are in 16-bit Windows, 32-bit Windows, and Windows+MS-DOS versions.    They can display a 
greeting message when they are run.    You can control the default Unzip To folder, whether the default 
Overwrite files without prompting box is checked, and can specify a command to run after the unzip 
operation completes.
Self-Extractors for Software Installation
Self-Extractors for Software Installation take a bit more work to set up, but provide a more professional 
looking installation. You can customize the icon and text displayed in the self-extracting Zip file’s dialog 
box.    The self-extracting Zip file will create a temporary folder, unzip the files into the specified folder, run 
your setup program, wait for it to complete, then delete the temporary folder created in the first step.
For details on the differences, see the section titled Detailed Differences Between the Two Kinds of Self-
Extracting Files



Which Zip file would you like to make into a self-extracting Zip?
WinZip Self-Extractor turns an existing Zip file (with a .zip file type or extension) into a self-extracting Zip 
file.    The self-extracting Zip file will have the same filename as the original .ZIP file.    The file type will 
be .EXE.
Type the full filename of the Zip file, or click the Browse button to search for a .Zip file.
Click the Run WinZip button if you would like to create a Zip file with WinZip.    Then select Make EXE 
from WinZip’s Actions menu to return to WinZip Self-Extractor.
Once you have selected a Zip file, click Next to specify options, or Finish to create a self-extracting Zip 
file with the default options.



Creating a Message File
Standard Self-Extracting Zip Files can display a greeting message box when they are run.    Leave this 
field blank if you do not want your self-extracting Zip file to display a greeting message.
Greeting messages can be up to 512 characters in length (512 characters is the longest message allowed
by a standard Windows message box).    Formatting the text in this message box can be tricky: the exact 
size of the message window varies depending on your video configuration, so the text should only contain
carriage returns and line feeds when you want a blank line to separate text.    One good way to create this
file is as follows:
· Run Notepad
· Check the "Word Wrap" entry in the Edit pull-down menu if it is not already checked
· Type the text WITHOUT pressing the Enter key to end a line. In other words, let the "Word Wrap" 

feature wrap the text. Press the Enter key ONLY when you want a blank line to separate text; in that 
case press the Enter key TWICE.

· Resize the Notepad window to a few different sizes to be sure the text looks "right", then save the file.
This field is the equivalent of the -m command line option.
Click Next to specify options, or Finish to create a self-extracting Zip file with the default options.



Default Unzip Folder
You can specify the default target folder for the unzip operation.    If you leave this field blank the folder 
specified by the user's TEMP= environment variable is used.    This is generally the best choice if your Zip 
file contains a SETUP program that will copy the unzipped contents of the Zip to another folder.    If you do
not have a SETUP program you will probably want to choose a name related to the contents of the Zip.    
For example, you might use "c:\modem" for a Zip containing a help file called "modem.hlp".
If you use this option and create a self-extractor for MS-DOS and Windows, you will receive a warning 
message stating that the Unzip Folder will be ignored if run under MS-DOS.
This field is the equivalent of the -d command line option.
Click Next to specify options, or Finish to create a self-extracting Zip file with the default options.



Command To Issue After Unzip Operation
You can specify the optional command to execute when the unzip operation completes.    If you leave this 
field blank no command will be issued.
The command will be issued from the user's Unzip To folder, so folder information is generally not 
needed in this command.    The Windows WinExec API is used to run this command.    You must specify 
a command name, not just a filename.    Typical commands are:

· WINHELP myfile.HLP - to start the Windows HELP engine on a file in the Zip
· NOTEPAD myfile.TXT - to start NOTEPAD on a file in the Zip

If you use this option and create a self-extractor for MS-DOS and Windows, you will receive a warning 
message stating that the command will be ignored if run under MS-DOS.

This field is the equivalent of the -c command line option.
Click Next to specify options, or Finish to create a self-extracting Zip file with the default options.



Icon For Self-Extracting Zip File
You can specify an icon to use for the self-extracting Zip file.    If you leave this field blank the default icon 
will be issued. This file must be in the standard Windows icon file format.    You can create files in this 
format with AppStudio, the ImagEdit program distributed with the Windows SDK, or with many third party 
graphics tools.
Technical details:    WinZip Self-Extractor will copy the 32 by 32 pixel and 16 by 16 pixel images from the 
specified icon file.    Only 16-color images are used.    If your icon file does not include a 16 by 16 pixel 
image, and you view the resulting self-extracting Zip file in “Small Icon” view,    Windows will display a 
shrunken version of your 32 by 32 icon image.
This field is the equivalent of the -i command line option. 



Type of Standard Self-Extractor
Four types of Standard Self-Extracting Zip Files can be created:

· Standard 16-bit Windows This option creates self-extracting Zip files with 16-bit long filename 
support and a progress meter.    If long filenames are used and the self-extracting Zip is run on a 
system that does not support the 16-bit long filename APIs (e.g. the current version of Windows 
NT), a message box is displayed warning the user of potential problems, and any long filenames 
will be truncated.    If long names are not used, these files work under all versions of Windows.

· Compact 16-bit Windows This option creates self-extracting Zip files without long filename 
support or a progress meter.    If long filenames are not used, these files work under Windows 3.1,
Windows 95, and Windows NT.    (Historical note: these files are almost identical to those created 
by WinZip Self-Extractor 1.0).

· MS-DOS and 16-bit Windows This option creates self-extracting Zip files that can be run either 
from Windows or from the MS-DOS prompt.    Some limitations apply to these files; see the 
section titled Limitations on “MS-DOS and 16-bit Windows” Self-Extractors for details.

· 32-bit Windows 95 and NT This option creates self-extracting Zip files that include long filename 
support under Windows 95 and Windows NT.    Because these self-extracting files are full 32-bit 
programs they will not run under Windows 3.1.

These options correspond to the -standard, -compact, -dos, and -win32 command line options.
Click Next to specify options, or Finish to create a self-extracting Zip file with the default options.



Limitations on “MS-DOS and 16-bit Windows” Self-Extractors
The following limitations apply to “MS-DOS and 16-bit Windows” Self-Extractors:

1. Long filenames are not supported, since MS-DOS does not support them.
2. When run under MS-DOS, the following options are ignored:

· The “Unzip To” folder.    Files are always unzipped into the current working directory.
· The command to execute after unzipping.    Since MS-DOS and Windows commands are 

almost always incompatible, no attempt is made to run the specified command under MS-
DOS.

· The “Default to overwriting files without prompting” setting.    Files are always overwritten.
· The “Unzip automatically” option.    The user is always prompted before unzipping.
· The “Icon” option.    The default WinZip Self-Extractor icon is always used.

3. Password protected zip files are not supported.



Miscellaneous Standard Self-Extractor Options
You can control the following Standard Self-Extracting Zip File options in this panel:

· Whether the CTL3D.DLL should be used to generate 3D effects for the self-extracting Zip file.    
CTL3D.DLL is used by many applications to generate 3D effects so there is a good chance it will 
exist on a lot of target systems.    If this option is specified WinZip will try to load CTL3DV2.DLL, 
and if not found, will try to load CTL3D.DLL.    Note that there is no way for WinZip Self-Extractor 
to guarantee that the CTL3D*.DLL on the target system will function properly.    This field is the 
equivalent of the -3 command line option.

· Whether the Overwrite files without prompting checkbox in the self-extracting Zip file is on or 
off by default.    This is equivalent to the -overwrite and -nooverwrite command line options.

· Whether the self-extracting Zip file should unzip itself automatically.    This is equivalent to the -
auto command line option. Use this new feature with caution:    if you are planning to post this file 
on the Internet or an online service like CompuServe or AOL, you should be aware that some 
sysops refuse to accept files that unzip without a prompt.

· Whether English language or German language self-extracting Zip files should be built.    These 
radio buttons correspond to the -le and -lg command line options.

Click Next to view a summary of the selected options, or Finish to create a self-extracting Zip file 
immediately.



Ready to Create Self-Extracting Zip File
Click Next or Finish to build a self-extracting Zip file with the options shown.    If you would like to change 
some of the options, just click Back to move to the appropriate panel.



Self-Extracting Zip File Has Been Created
The self-extracting Zip file has been created with the options you specified.    Be sure to test it before 
distributing the file!    It is always a good idea to test under all target operating systems: for example, if 
your file is intended for all versions of Windows, test under Windows 3.1, Windows 95, and Windows NT.   
If the Test self-extracting Zip file now button is checked, the self-extracting file will be run when you 
click Next.



Command To Issue When Unzip Operation Completes
You must specify a command to execute (usually “setup.exe”) when the unzip operation completes.
The self-extracting Zip file will perform the following steps when the user clicks the Setup button:
1. Create a temporary folder
2. Unzip all files in the Zip file to the temporary folder
3. Run the specified command using the Windows WinExec API
4. Wait for the command to complete
5. Remove all files in the temporary folder created in the first step
Notes:
These steps are designed to work with most setup programs, which copy files from a source folder 
(created in step 1 above) to a user-specified destination folder.
The self-extracting Zip file makes the temporary folder the “current working folder” before running the 
specified command, so you normally should not specify folder information in the Command to issue field.
Using the Wait for field:
The Wait for field is normally not needed, but some setup programs, including the one used by Sterling 
Software’s InstallShield, launch another program to handle the installation, then terminate immediately.    
In these cases you need to use the Wait For field.    This tells the self-extractor that, before deleting the 
files in the temporary folder, it should wait for the program specified in Command to issue field, then for 
the name in the Wait for field.    When building 32-bit self-extracting Zip files, you must specify the file 
name of the EXE file you want the self-extracting Zip file to wait for.    For technical reasons, when building
16-bit self-extracting Zip files, you must specify the module name, not the file name.    The module name 
is often but not always the same as the file name.    One way to determine the module name of an EXE 
file is to use the Windows 95 QuickView utility to view the file.
Note: if you have trouble with this option, one alternative is to use a Standard Self-Extracting Zip File.



Configuration Files
This panel contains three input fields that control the appearance of the self-extracting Zip file:
1. You must specify the name of a file containing text for the dialog box.    The text in this file is limited to 

256 characters.
2. You can specify an icon for the dialog box.    This file must be in the standard Windows icon file 

format.    You can create files in this format with AppStudio, the ImagEdit program distributed with the 
Windows SDK, or with many third party graphics tools.

3. You can specify the name of a file with additional text for the About box.    This text in this file is limited
to 256 characters.

One way to create these text files is as follows:
· Run Notepad
· Check the "Word Wrap" entry in the Edit pull-down menu if it is not already checked
· Type the text WITHOUT pressing the Enter key to end a line. In other words, let the "Word Wrap" 

feature wrap the text. Press the Enter key ONLY when you want a blank line to separate text; in that 
case press the Enter key TWICE.

· Resize the Notepad window to a few different sizes to be sure the text looks "right", then save the file.



Miscellaneous Options
You can control the following options in this panel:

· Whether the CTL3D.DLL should be used to generate 3D effects for the self-extracting Zip file 
(Windows 95 and Windows NT 4.0 automatically generate 3D effects, even if this option is not 
specified).    CTL3D.DLL is used by many applications to generate 3D effects so there is a good 
chance it will exist on a lot of target systems.    If this option is specified WinZip will try to load 
CTL3DV2.DLL, and if not found, will try to load CTL3D.DLL.    Note that there is no way for WinZip
Self-Extractor to guarantee that the CTL3D*.DLL on the target system will function properly.    This
field is the equivalent of the -3 command line option.

· Whether a 16-bit or 32-bit self-extracting Zip file is built.    32-bit self-extracting Zip files can ONLY 
be run under Windows 95 or Windows NT.    This option corresponds to the -standard and -win32 
command line options.

· Whether the self-extracting Zip file should unzip itself automatically.    This is equivalent to the -
auto command line option. Use this new feature with caution:    if you are planning to post this file 
on the Internet or an online service like CompuServe or AOL, you should be aware that some 
sysops refuse to accept files that unzip without a prompt.

· Whether English language or German language self-extracting Zip files should be built.    These 
radio buttons correspond to the -le and -lg command line options.



Notes for InstallShield Users
The following notes apply if you are building a Self-Extractor for Software Installation and plan to run the 
SETUP.EXE program from InstallShield Software Corporation’s InstallShield 3 or the InstallShield SDK 
Edition (distributed with Microsoft’s Visual C++ 4.x disk).
· When using InstallShield with Self-Extractors for Software Installation, you must include the 

InstallShield file _ISDEL.EXE in your self-extracting zip file.    _ISDEL is normally part of all distribution
packages created with InstallShield 3.0, including the InstallShield SDK Edition on the Microsoft 
Visual C++ CD-ROM.    _ISDEL.EXE is not part of the InstallShield 2.x or with the InstallShield SDK 
Edition on the Win32 SDK, so you cannot use WinZip Self-Extractor to create Self-Extractors for 
Software Installation with these old versions of InstallShield.

· You must either use the -ishield3 command line parameter or specify a value in the WinZip Self-
Extractor Wizard Wait for field when running InstallShield’s SETUP program from a Self-Extracting 
Zip file for Software Installation.    Normally the value in the Wait for field is automatically filled in.    
This value should be _DELIS when building 16-bit self-extracting Zip files, or _ISDEL when building 
32-bit self-extracting Zip files.

· Try creating your InstallShield 3.0 distribution files without any compression (use the -sn switch on 
the icomp command). Then zip the files using maximum compression.    Depending on the files you 
are distribution, this can result in smaller self-extracting Zip files.    For example, if you compress the 
WinZip 6.1 evaluation version distribution files with icomp, the resulting zip file is 12% larger that 
when you turn off icomp compression.

Note: InstallShield is a trademark of InstallShield Software Corporation.



Register WinZip Self-Extractor
Please enter your registration information exactly as you received it from Nico Mak Computing, Inc.    If 
you have trouble, please write to support@winzip.com or 70056,241 on CompuServe.
Note that your organization name will be embedded in all self-extracting Zip files you create.



Detailed Differences Between Standard and Software 
Installation Self-Extractors

Standard Software Installation
Receiver controls Unzip To folder Yes No; a temporary folder is created and later 

deleted
Receiver controls whether 
command is run after Unzip 
operation completes

Yes No; the specified command is always run 
after the Unzip operation completes

Receiver controls whether files are 
overwritten automatically

Yes Not applicable; files are unzipped into a 
newly created temporary folder

Optional greeting message us 
displayed when self-extractor is 
started

Yes No

MS-DOS+Windows version 
available

Yes No

16-bit Windows version available Yes Yes
32-bit Windows version available Yes Yes
German and English versions 
available

Yes Yes

Unzipped files are automatically 
deleted when command completes

No Yes

Dialog text and icon are 
configurable

No Yes

To create a Standard Self-Extractor, select the Standard Self-Extractor radio button in the second 
Wizard panel.    When using command line parameters, Standard Self-Extractors are created unless you 
specify the -setup switch.
To create a Self-Extractor for software installation, select the Self-Extractor for Software Installation 
radio button in the second Wizard panel.    Or, when using command line parameters, specify the -setup 
switch.

Related Topics:

Two Kinds of Self-Extracting Files
 




